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About this document: 
 

This document will provide a simple write-up on how to get started with using SquidNet.  

 

Itôs assumed that the reader is familiar with the rendering and compositing applications that are 

installed on their system. This manual will not attempt to cover any material related to those 

applications.  
 
For any suggestions or comments, feel free to contact us; contact information can be found in the 
Help menu in the SquidNet user Interface console and on our website at 
http://www.squidnetsoftware.com/. 
 
Always check website http://www.squidnetsoftware.com for the latest documentation 
updates.

http://www.squidnetsoftware.com/
http://www.squidnetsoftware.com/


 SquidNet Network Render Manager ð Getting Started  

This document is published by SquidNet Software, Inc. 

Ò 2011, SquidNet Software, Inc.  All rights reserved. 
1 

1 Getting Started with SquidNet 
 

1.1 Terminology 
 
For the sake of this document and others, specific terminology will be as described in the 
following table: 
 

Term Description 

SMC  SquidNet Management Console ï Main SquidNet User Interface. 

Render Node Computer that processes SquidNet job requests. Typically this refers to SLAVE 
nodes when system is configured in a CLIENT/MASTER/SLAVE configuration. 

SquidNet Job User created entity that contains job processing instructions for render nodes. 

Segment A single part of a larger whole. For example, a single frame from an animation 
film. 

Job Slice One or more segments combined to form one processing unit. 

Job Queue Network repository of active render or processing jobs. 

Job Profile Saved SquidNet job that can be edited and resubmitted for later processing. 

Pool A group of render nodes configured to process specific types of render jobs. 

Cross-Platform Processing compatibility amongst different computer systems and operating 
systems. 

Render farm Two or computers networked together to form a distributed multi-processing 
environment. The term usually applies to networked systems used in the 3D 
animation and film industries. Job templates create job profiles and job profiles 
are used to submit jobs. This could be thought of in this manner: job-template-
>profile->job-request->job-slices->rendered-frames. 

Template Form The dialog that contains all of the possible attributes and options for a specific 
rendering or compositing application.  

Application Task An operating system process thatôs responsible for executing a specific action. 
For SquidNet, this can be any of the spawned applications used to process a 
particular request. 

 
 

1.2 Operating System Requirements 
Requirements for SquidNet vary according to the operating system. Here are some basic 
operating system features to consider: 
 
For WINDOWS hosts: 

¶ Use 64-bit versions to take full advantage of the larger memory capabilities. SquidNet will 
work just fine on a 32-bit version will but will be limited to 3Gbytes of addressable 
memory space (if operating system is configured properly). 

¶ Use WINDOWS SERVER versions to avoid the 10-connection TCP/IP limit imposed by 
non-server O/S versions (WIN7, VISTA, WIN-XP and WIN2000). 

¶ Using WINDOWS HOME editions is not recommended because of the lack of network 
connectivity support. 

¶ Use of a Network Access Storage server (NAS) is highly recommended. NAS devices 
are relatively easy to configure and provide a better data protection option than 
WINDOWS resident drives. Consider using a NAS that supports RAID technology. 
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For Linux hosts: 

¶ Use 64-bit versions to take full advantage of the larger memory capabilities. SquidNet will 
work just fine on a 32-bit version will but will be limited to 4Gbytes of addressable 
memory space. 

¶ Use a SAMBA server to allow local disk volumes to be used as network storage devices. 
If used as a network device, make sure to acquire a large capacity disk drive.  

¶ Lower cost: Most Linux distributions are free (or close to it) so they provide a better cost 
alternative to Microsoftôs licensing models. 

 
In general, the more processing power you have, the better. If possible, always try to purchase 
multi-core machines. Most modern 3D rendering and compositing applications are written to take 
full advantage of multi-core systems by using multi-threaded programming techniques. 
 
Consult your hardware and software documentation for optimal performance requirements. 

1.3 NAS/SAMBA Storage Devices 
If your system has 10 or more render nodes, itôs strongly recommended that you use either a 
Network Access Storage (NAS) device or a Linux machine with a configured SAMBA server (A 
free open source solution can be found at http://www.freenas.org). Using either will keep you from 
getting Windows System Error #267 errors when too many connection attempts are made to a 
WINDOWS network drive. (This does not apply if youôre using a WINDOWS Server configuration 
with the appropriate Microsoft user licenses.) 
 

 
Recommended SquidNet Network Configuration 

http://www.freenas.org/
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1.4 Installation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
SquidNet jobs are always processed under an administrative (WINDOWS) or root (Linux) 
account. Itôs advisable to have a dedicated SquidNet account with full privileges on each node 
that the software will be installed on. Most SquidNet users create a special ñsquidnetò admin 
account.  
 
Note: on WINDOWS SERVER nodes, when a new user account is created the account is 
NOT part of the Administrators Group (only part of Users Group).  
 

Important: Make sure that the ñsquidnetò account has full read/write/access permissions on all 

network resources. On WINDOWS, be sure to add the "squidnet" account to access control lists 
on all network share folders that will need to be accessed. 
  
For complete installation instructions please refer to the following documents: 
 

¶ SquidNet Installation Guide for Windows. 

¶ SquidNet Installation Guide for Linux. 
 

1.4.1 Installation Prerequisites 
 
In order for SquidNet to operate effectively, please take into account the following: 
 

1. Make sure that the account that SquidNet is installed under has full access permissions to 
all network folders. A good way to verify this is to login into the SquidNet account and 
attempt to access network folders. 

2. It's recommended that the SquidNet account on each installed node have the same 
password. Using different passwords for the same SquidNet account will create ñno 
permissionò issues with queued jobs. 

3. Although SquidNet will work fine with WINDOWS UAC (User Account Control) enabled, it's 
recommended that it be disabled on nodes that will be used to submit jobs. 

4. Make sure that your anti-virus software does not interfere with SquidNet applications and 
services. See installation guides for lists of TCP/UDP ports that SquidNet uses. 

5. Note the installation paths of your installed software applications (Maya, Modo, Lightwave, 
etcé). SquidNet will need to be aware of these in order for it to submit job requests. 

Important 
 
The biggest challenge in setting up a render farm is the initial setup and 
configuration. Proper network setup can often be a very daunting and 
confusing task. Take your time and be patient. Read thru all available 
documentation and make sure you understand the unique aspects of your 
system. Send us an email if you're having trouble setting up your network. 
Email and remote-login support is always available at no charge. 
 
In most cases, setup problems are always related to permission issues on 
network resources. Make sure project files, content and output folders all 

have read and/or write access rights. 
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6. Always run the SquidNet verification test to make sure that your system is running 
correctly. 
 

NOTE: Some SquidNet User Interface features will not be enabled with Deluxe version. 
Please request an evaluation license to unlock all features. 

1.4.2 Network Prerequisites 
 
From a network perspective, consult with your IT professional to ensure that your network is 
properly configured. Some recommendations include: 
 

1. It's recommended that static IP address be used for all nodes. Do not use DHCP 
addressing because of the likelihood that nodes will change their IP address between 
restarts. 

2. If any node has more than one network interface enabled (multi-interface or multi-
subnet configuration), use the Network Address Selector dialog (Configuration-
>Network Address...) in the Network view to select the network interface that SquidNet 
will use on that node. By default SquidNet auto-detects the local network interface. 

3. In a cross-platform environment, make sure that all nodes can reach each other by adding 
LINUX and Mac/OSX hostnames to WINDOWS' 
C:\Windows\System32\drivers\etc\hosts file. Additionally, add WINDOWS node names 
to each LINUX/OSX node's /etc/hosts file. 

4. Use SquidNet's Hostname editor (Admin->Hostname Editor...) to remotely add network 
node names and addresses to all network nodes. 

5. Make sure that the SquidNet account has full access to all network shared resources 
(NAS, Mapped drives, etc...) 

 

 
Network Address Selector Dialog 
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Hostname Editor 

 
  

1.4.3 Application Setup Tips 
 
To ensure that SquidNet integrates seamlessly into your production workflow, a list of helpful 
application setup tips is provided below: 
 

Application Tips 

Blender 1. SquidNet provides plugins for Blender3D 2.4x and 2.5x 
environments. Make sure that you select the correct installation 
type in the Blender3D template. 

2. Mixed Blender3D versions are supported. Just create a separate 
pool for each version. 

3. Important: With Blender3D 2.5x installations, Blender has trouble 
locating Python libraries when executed within a SquidNet job. 
The workaround is to set the path "blender.exe" in your system 
$PATH variable. You may use the Application Path Manager to 
set the correct Blender.exe path on each node. 

LightWave 1. Make sure to reference the correct configuration files in the LW job 
template. 

2. Make sure that your CFG files don't have references to local drives 
(C:\, D:\, etc...). All paths must be either mapped drives or UNC 
paths. Note: On WINDOWS VISTA, LW config files are stored in 
C:\Users\<username>\.NewTek\LightWave\10.0. 

3. Don't forget to set the correct Project path in job template.  

Modo 4. Make sure to install the proper plugin for the version of Modo that 
you're using. In most cases, the SquidNet installer will attempt to 
auto-copy the correct plugin into Modo's plugins folder. 

XSI/Softimage 1. When using XSI plugins that are referenced within your scenes, 
make sure to "install" these plugins (from XSI UI) in the account 
that SquidNet is installed under (not the WINDOWS account that 
was used to run the SquidNet installer). Not doing so will result in 
"plugin not found" errors for your XSI jobs. 
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1.5 Peer-to-Peer vs Client-Master-Slave 
 

 
Node Configuration Options 

 
SquidNet supports two network configurations: Peer-to-Peer (P2P) and Client-Master-Slave 
(CMS). In a P2P configuration, each node acts as a submitting workstation and (optionally) as a 
processing node. In a Client-Master-Slave configuration, nodes are separated into clients 
(submitting workstations), slaves (processing nodes) and a single master (controller). The master 
node manages all jobs on the queue and is the central hub of the network. All job transactions are 
routed thru the master. In a P2P configuration, all P2P nodes will process each other's jobs. In a 
CMS configuration, clients submit jobs to the master which, in turn, assigns them to available 
slave render nodes. Note: CMS mode is only configurable with an installed SquidNet Pro 
license. Please request an evaluation license by sending us an email. 
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Important!!! 

If your render farm has 5 or more processing nodes, it's highly recommended that you 
configure your network in a client/Master/Slave setup. 

 

1.5.1 Setting up P2P Mode 
 
When SquidNet is installed, the default processing mode is P2P so no special configuration is 
required. 
 
To reconfigure a node to P2P mode open the Network View window, right-click and select the 
"Set as Peer..." option in the configuration menu. 
 
Note: To reconfigure a master node to a P2P node, make sure to disassociate (convert back to 
peer) all client and slave nodes first. Also, make sure that the job queue is completely empty. 
 

1.5.2 Setting up CMS Mode 
 
As stated above, if your render farm has more than 5 nodes, it's recommended that you use 
SquidNet in CMS mode. Before reconfiguring your network, consider the following: 
 

1. Select a single node on your render farm to act as a master (controller). The master node 
should be a node that will be running most of the time. A reliable user workstation is 
always a good candidate. 

2. Determine which nodes will act as client nodes. Client nodes are user workstations that 
submit jobs to the SquidNet network. Clients nodes can be optionally configured to 
process jobs using one of the following methods: 

a. Never: Node can only submit jobs. It can never process (render) any jobs. 
b. When user is logged out: Node can only process jobs when no users are 

actively logged in. 
c. Low priority: Process jobs at any time but only process them at the lowest 

possible CPU priority level.  
3. Determine which nodes will act as slave nodes. Slave nodes are the work horses of the 

network and are controlled by the master. Slave nodes can never submit jobs. 
 
To set up your farm in a CMS configuration, do the following: 
 

1. Open the Network View window. 
2. Right-click anywhere on the window and select the "Select Columns..." menu item. 
3. Select the "Node Type" field so that the node type column appears in the network view 

window. 
4. Make sure that all nodes are identified as type "Peer". 
5. Right-click on a node that you've selected to be the master node. Use the "Configure 

Master..." menu option to configure master node settings. Note: Master node must be 
configured first. 

6. Right-click on the nodes that are to be client nodes. Use the "Configure Client(s)..." menu 
option to configure client node settings. 

7. Right-click on the nodes that are to be slave nodes. 
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Note: To unconfigure all nodes from CMS mode, make sure to disassociate all client and slave 
nodes first. Only then will you be able to unconfigure the master node. 

1.6 User Modes 
 
SquidNet support two different user modes: single-user mode and multi-user mode. 
 
In single-user mode, each running instance of the SquidNet User interface has: 

¶ Complete control over all features. No features are disabled (assuming you have a 
SquidNet PRO license installed). 

¶ Users have complete control over jobs submitted from their local workstations.  

¶ Users cannot alter or remove other userôs jobs. 

¶ Users are free to shutdown/restart or power-down any machine on the network. 
 
In multi-user mode: 

¶ A special ñsquidnetò administrator account is used to manage all accounts. This account 
cannot be removed. Use this account to create individual; user accounts. 

¶ Users must use their assigned login id and password to log in to the system. 

¶ Users are granted rights to access specific features of the system (job submission, queue 
monitoring, etcé). 

 

 
Login prompt in multi-user mode. 

 
If youôll be using SquidNet in a multi-user environment, youôll need to set the default user account 
database path on each one of your userôs workstations. This path MUST be a network-shared 
directory thatôs accessible by all nodes. Itôs advisable to set read-only permissions on this path for 
non-administrative accounts. 
 
 

 
Prompt for user database path 
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It more than 2 or 3 users will be submitting jobs to the network queue itôs recommended that 
SquidNet be used in multi-user mode. 
 

1.7 Submitting cross-platform job requests 
If your system configuration consists of WINDOWS and LINUX (OSX support coming soon) 
computers you can submit job requests to both systems by setting up the appropriate path 
translations. Path translations allow SquidNet to submit the same job request to different 
operating system configurations.  
 
To setup a path translation, select the ñTranslationsò button on the job submission form to bring 
up the Path Translation dialog (or access from Tools menu) 
 

 
Path Translation Dialog. 

 
Within the Path Translation dialog, define the mapping between WINDOWS and LINUX paths. 
Once you define your path mappings, you can refer to them within your job template. Make sure 
to enclose the translation path within the $XPATH(é) macro (example: 
$XPATH(MAYA_RENDER) ). 
 

 
Path Translation macros used in job template. 

 
See SquidNet-Setting-up-cross-plaform-renderfarm.pdf document on setup instructions for 
cross-platform job submissions. 
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1.8 Mapped Drive vs UNC paths 
SquidNet supports both mapped drives and UNC paths. Mapped drives are designated by local 
drive letters (G:, H:, etcé)  that can point to local or network-mapped directories (example: 
T:\myprojectfiles\é). UNC (Universal Naming Convention) paths are global in scope and always 
point to a network shared directory (example: \\COMPUTER-NAME\myprojectfiles\é). Internally, 
all mapped drives have a UNC path. 
 
Using either is basically a matter of preference. However, UNC paths are easier to use because 
their destination paths are more easily distinguishable whereas with mapped-drives, their actual 
location is hidden behind the drive letter(s). 
 
Note: When using mapped-drives, SquidNet will always mirror the submitting workstations 
mapped-drives on the rendering nodes. For example: If a submitting workstation has drive X:\ 
mapped to \\NASBOX\Projects, each rendering node will create the same mapping before the 
rendering process begins. 
 

1.9 Configuration settings path 
 
By default, all SquidNet configuration settings are stored in the local installation directory and for 
standalone (single-user) mode this setting is preferred. However, in a multi-user environment, you 
should point the settings configuration path to a network-share directory. Doing so will prevent 
you from having to enter the same information (email settings, pool settings, etcé) on each node. 
 
The configuration path can be changed from the SquidNet user interface toolbar menu: 
 

¶ Select Admin->Preferenceséò 
 
 

 
 
 

1.10 Project Manager 
 
The SquidNet User Interface (UI) is built upon a project-oriented framework. All jobs are stored in 
project folders. Use the Project Manager (Project->Open Project Manageréò to create a new 
project folder. 
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Project Manager Dialog 

 
If youôre planning on using SquidNet in a multi-user environment, itôs advisable to create project 
folders on a network share to allow concurrent access by all users. 
 

1.11 Linux SMC Console 
 
If youôre using SquidNet in a multi-platform environment (WINDOWS, LINUX and OSX) please 
note that as of this writing, there is no SquidNet user interface available for Linux or OSX 
machines. You will need to manage the network from a SquidNet user interface running on a 
WINDOWS machine. 

1.12 Rendering Application setup 
 
Itôs assumed that your 3

rd
 party compositing and rendering applications are already installed on 

your system. SquidNet uses your applicationôs command line program to process job requests. 
For example: with Maya jobs, SquidNet launches a processing task (a job request) using the 
Mayaôs ñrender.exeò command line program. The table below showôs some the rendering 
command line programs called by SquidNet: 
 

Application Command line used 

3DSMAX 3dsmaxcmd.exe 

After Effects aerender.exe 

Blende3D  blender.exe (ñblenderò on Linux) 

Lightwave lwsn.exe 

Maya render.exe 

Modo modo_cl.exe 

XSI xsibatch.bat 

 
 
In order for SquidNet to ñfindò the command line programs, youôll need to do one of the following: 
 

1. Use the application path in your job requests (ex: C:\Program 
Files\maya\bin\render.exe). This method is fine as long as the application is installed in 
the same folder path on all render nodes. 

2. Modify the system PATH variable on each render node to include your applicationôs 
command line path. For example, append ñC:\Program Files\maya\bin\ò to the end of 
your systemsô PATH variable. When choosing this method, make sure to restart the 
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SquidNet service (ñnet stop squidserverò and ñnet start squidserverò from command 
line) or reboot node for changes to take effect. 

3. (Recommended) Use the Application Path Manager within the SquidNet user interface 
to ñtellò SquidNet where to find specific applications. 

4. In cases where youôd like to access command line applications that are installed on 
different paths on your farm, create your path profile using the Application Path Manager 
and reference that path in your job template using the $APP() macro. For example, if 
youôd like SquidNet to process a Lightwave scene file using the lwsn.exe (ScreamerNet) 
application on 3 machines with 3 different installation paths do the following: 

a. Create a path profile in the Application Path Manager. For example 
ñLIGHTWAVE-MIXEDò. 

b. Add one path entry for each render node in LIGHTWAVE-MIXED path profile. 
c. In the ñapplicationò field on the Lightwave job template, replace the ñlwsn.exeò 

program name with the $APP(LIGHTWAVE-MIXED) macro. 
d. When the job is submitted, SquidNet will translate the correct paths on each 

render node. 
e. Use this method as well for cross-platform (WINDOWS, LINUX, OSX) installation 

paths as well. 
 
 

 
Application Path Manager Dialog 

 
 
You may use the Path Check tool (Tools->Path Checké) within the SquidNet UI to check if a 
particular application can be found on each of your application hosts. 
 


